
  

 

  

ReleaseInfo 

Innovator 14.0 

Innovator 14.0.1.10828 



ReleaseInfo Innovator 14.0 (Innovator 14.0.1.10828)  

 I  

Contents  

Innovator 14.0 (Innovator 14.0.1.10828) ................................................................................................................................................ 1 

 Version Consistency .................................................................................................................................................................. 1 
Overview of Version Numbers (Builds) ............................................................................................................................................. 1 
About the API Documentation .......................................................................................................................................................... 1 

General Functions ................................................................................................................................................................................ 1 
 Model Server Service Allows Port Specification ........................................................................................................................ 1 

Model Editor ........................................................................................................................................................................................ 1 
 Dependencies of Diagrams ........................................................................................................................................................ 1 
 Backstage View "Change Sets" Remembers Additional Settings ............................................................................................... 1 
 Changes in Element Selection Dialog ........................................................................................................................................ 1 
 Specification  Editor: Navigation in Tables ................................................................................................................................ 2 
 SQLServer no Longer Supports "timestamp" ............................................................................................................................ 2 
 Synchronize Model Elements: Performance of Comparison Accelerated ................................................................................. 2 
 Backstage: Window Buttons Visibility ....................................................................................................................................... 2 
 DDL Import Supports ON Clause ............................................................................................................................................... 2 
 Documentation: Output of Text in Tables ................................................................................................................................. 2 
 Exasol: Index Positions of JDBC Driver Are Ignored ................................................................................................................... 2 
 Page Layout: Loading and Saving Templates ............................................................................................................................. 2 

Configuration ....................................................................................................................................................................................... 2 
 Stereotype of Innovator Model is not a Valid Owner of a Stereotype Property ....................................................................... 2 

Innovator 14.0 (Innovator 14.0.1.10726) ................................................................................................................................................ 3 
General Functions ................................................................................................................................................................................ 3 
 Java Version............................................................................................................................................................................... 3 
 Support for Database Systems Exasol and PostgreSQL ............................................................................................................. 3 
 32-Bit Support Not Applicable ................................................................................................................................................... 3 
 Environment Variables in Engineering Actions ......................................................................................................................... 3 
 Interface of Model Editor and Administration Program............................................................................................................ 3 
 Privilege "Versioning" Renamed "Use Model Fragments" ........................................................................................................ 3 
 Support of Database Systems Updated ..................................................................................................................................... 3 
 System Requirement  Java ........................................................................................................................................................ 4 
 System Requirement .NET 4.6.1 ................................................................................................................................................ 4 

Administration ..................................................................................................................................................................................... 4 
 Administration Program: Features Extended ............................................................................................................................ 4 
 Managing Model Versions ......................................................................................................................................................... 5 
 User Management: Marking of Non-Existing Projects .............................................................................................................. 5 
 User Management: Rule Shows Project Name .......................................................................................................................... 5 
 Service Options ......................................................................................................................................................................... 5 

Model Editor ........................................................................................................................................................................................ 5 
 Comparison of Single Profiles .................................................................................................................................................... 5 
 Composite Structure Diagram Supports Association Classes .................................................................................................... 5 
 Composite Structure Diagram: Display of Classifiers ................................................................................................................ 5 
 Composite Structure Diagram: Improved Handling of Ports and Socket/Balls ......................................................................... 6 
 Concept Diagram: Multiple Display of Concepts ....................................................................................................................... 6 
 Creating New Models: Setting Options for Change Logging...................................................................................................... 6 
 Details Area: Expand and Collapse Subnodes ........................................................................................................................... 6 
 Dialog for Element Selection ..................................................................................................................................................... 6 
 Merge: Reference Time of the Comparison for Model Versions ............................................................................................... 6 
 Merge: Using Change-Sets ........................................................................................................................................................ 6 
 Sequence Diagram: Copying Possible ........................................................................................................................................ 7 
 Sequence Diagram: Interaction Supports the Reconnection of Messages ................................................................................ 7 
 Sequence Diagram: Lifeline with Typed Attribute ..................................................................................................................... 7 
 Splitting Merged Tables............................................................................................................................................................. 7 
 Use Case Diagram Allows Associations to Components ............................................................................................................ 7 
 Verification Routine "Chapter has invalid filter 'Name'. [VFY548]" ........................................................................................... 7 



ReleaseInfo Innovator 14.0 (Innovator 14.0.1.10828)  

 II  

 "Select an Element" Dialog: Stereotypes Filterable .................................................................................................................. 7 
 Backstage View "Verify & Export" ............................................................................................................................................. 8 
 Change DB Schema in the DB Manager ..................................................................................................................................... 8 
 Composite Structure Diagram: Free Moving of Socket/Ball Nodes ........................................................................................... 8 
 Composite Structure Diagram: Representation for New Nodes Controllable ........................................................................... 8 
 Database Reverse Engineering Using JDBC 6.0 ......................................................................................................................... 8 
 DB Configuration Via File ........................................................................................................................................................... 8 
 DB Manager: Integer Data Type of Microsoft SQL Server ......................................................................................................... 8 
 Details Tool Window Initial With One Visible Level .................................................................................................................. 9 
 Diagram: Extend Selection by All Elements of the Same Stereotype ........................................................................................ 9 
 Diagrams View Remains Visible When Creating Diagrams ........................................................................................................ 9 
 Documentation of Selected Elements ....................................................................................................................................... 9 
 History for Dependencies .......................................................................................................................................................... 9 
 Import of Model Fragments Revised ......................................................................................................................................... 9 
 Model Administrator Can Call Login Rules ................................................................................................................................ 9 
 Moving Diagram Nodes With the Right Mouse Button ........................................................................................................... 10 
 Non-Exclusive Expander for Tool Windows ............................................................................................................................. 10 
 Port Property "is behavior" ..................................................................................................................................................... 10 
 Printing Diagrams With Individual Sheet Layouts ................................................................................................................... 10 
 Register Tabs: Close All in Groups ........................................................................................................................................... 10 
 Repeating the Generation of Documentation ......................................................................................................................... 10 
 Skipping Dialogs ...................................................................................................................................................................... 10 
 Specification Editior: Adjustable Paragraph Spacing ............................................................................................................... 11 
 Structure Elements with Enhanced Context Menu ................................................................................................................. 11 
 Synchronize Model Elements: Element Selection Based on Change Set ................................................................................. 11 
 Synchronize Model Elements: Sort Order of Subelements ..................................................................................................... 11 
 Table Editor: Editing String-Value Stereotype Properties ....................................................................................................... 12 
 Undo Dependency Deletion .................................................................................................................................................... 12 
 Change Set: Register Change for Extensive Selection ............................................................................................................. 12 
 Concept Diagram: Separate Moving of Node Name is Prevented ........................................................................................... 12 
 Copy and Paste of a Diagram .................................................................................................................................................. 12 
 DDL Import Supports Columns with GO .................................................................................................................................. 12 
 Import of Model Fragments Prevents Contradicting Import of Profiles .................................................................................. 12 
 Mapping Does Not Change the Name of Sequence and Semantic Data Type ........................................................................ 12 
 Mapping Maps Default Value .................................................................................................................................................. 12 
 Merging Elements With Free Numbering ................................................................................................................................ 13 
 Navigation to Elements in the Verification Results Tool Window ........................................................................................... 13 
 Specification Editor for BI Tasks .............................................................................................................................................. 13 
 Specification Editor: Pasting Copied Elements ........................................................................................................................ 13 
 Specification Editor: Removal of Tables Without Columns ..................................................................................................... 13 
 Specification Editor: Remove Shading ..................................................................................................................................... 13 

Configuration ..................................................................................................................................................................................... 13 
 Configuration Editor: Limit Selection to Locally Defined Entries ............................................................................................. 13 
 Ignoring Imported Configuration Contents ............................................................................................................................. 13 
 Reference to Another Element................................................................................................................................................ 14 
 Static and Dynamic Value Lists for Integer and String Properties ........................................................................................... 14 
 Stereotype Properties Definable in Extension Profiles ............................................................................................................ 14 
 Database Options are Managed as Type System Options ....................................................................................................... 14 
 Option "Name is placeholder" is Not Applicable for Create Templates .................................................................................. 15 
 Option Files for ER-DB and DB-ER Mappings Removed ........................................................................................................... 15 
 Redefinition of Stereotypes and Control for Visibility and Order in Dialogs ........................................................................... 15 
 Stereotype Can Be Handled as Property ................................................................................................................................. 15 
 Uniqueness of Short Names .................................................................................................................................................... 15 
 Visibility and Order in Dialogs ................................................................................................................................................. 16 

 



ReleaseInfo Innovator 14.0 (Innovator 14.0.1.10828)  

 1  

Innovator 14.0 (Innovator 14.0.1.10828) 

 Version Consistency 

Please note when updating your Innovator installations:  

Identity of model server version and client version is highly recommended for safe use of Innovator. It is 
mandatory that model server and clients have identical release numbers (XX.X.X). 

Repositories updated by transformation cannot be used in older versions.  

Overview of Version Numbers (Builds) 

Product Description Version Number (Build) 

Innovator 14.0.1 Hotfix Version 14.0.1.10828 

Innovator 14.0.1 Version 14.0.1.10726 

About the API Documentation 

The API changes are continuously documented in the online help (see "User Customizations> 
Innovator SDK Documentation Library>Change Log"). 

General Functions 

 Model Server Service Allows Port Specification 

When installing a model server service, the"/t" option is allowed to specify a special port. 

Model Editor 

 Dependencies of Diagrams 

The "Go to>Linked Elements" command allows you to navigate between diagrams associated by 
dependencies. 

 Backstage View "Change Sets" Remembers Additional Settings 

The settings "Only active change sets" and "Only change sets with own participation" in the "Change Sets" 
backstage view are retained after the program restart. 

 Changes in Element Selection Dialog 

In the element selection dialog (namespace dialog) for properties with multiple selection, the OK button is not 
activated until a change has been made. 

 New Function 

 Changed 

 Fixed 
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 Specification  Editor: Navigation in Tables 

In the specification editor, the insertion point in tables can be moved to the left adjacent cell using the key 
combination [Shift]+[Tab]. 

 SQLServer no Longer Supports "timestamp" 

The data type "timestamp" is no longer supported by SQLServer and has been removed from the default 
profile "SQLServer Type System". 

The Deutsch data type "Zeitstempel" is mapped to "datetime2". 

 Synchronize Model Elements: Performance of Comparison Accelerated 

The comparison of small subsets of a model has been significantly accelerated. 

 Backstage: Window Buttons Visibility 

The minimize, maximize and close buttons are visible also in the gray color scheme when the backstage is 
open. 

 DDL Import Supports ON Clause 

When importing a DDL file, the ON clause of a FROM clause is supported. The ON clause is imported as an 
expression of the FROM clause and the From clauses and columns mentioned there are referenced.  
Example: CREATE VIEW v1 ( a, b ) AS SELECT t1.a, t2.b FROM table1 t1 LEFT OUTER JOIN table2 t2 ON t1.value 
= t2.value; 

 Documentation: Output of Text in Tables 

In the documentation, differently formatted text segments in tables of a specification text are output without 
line breaks. 

 Exasol: Index Positions of JDBC Driver Are Ignored 

Since the Exasol JDBC driver returns incorrect values for the positions of columns in keys and indexes, these 
are ignored. 

 Page Layout: Loading and Saving Templates 

The loading and saving of templates for the page layout in the "Page Setup" dialog is functional. 

Configuration 

 Stereotype of Innovator Model is not a Valid Owner of a Stereotype Property 

Stereotype properties can be defined using the redefined stereotype of the Innovator model. Normally, the 
redefined original stereotype can also be selected as the owner for a stereotype property. This is not 
permitted for the stereotype of the Innovator model. 
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Innovator 14.0 (Innovator 14.0.1.10726) 

General Functions 

 Java Version 

The user can call up information on Java in the model editor and in the administration program. In the "Help & 
Support" backstage view, you can open the "Additional Version and System Information" dialog, which 
displays the active Java version and the source in which it is defined as active in the "Java" area. The usable 
and installed Java versions are also listed. If there is no Java version, then there are corresponding notes for 
their installation instead. 

When engineering actions, documentation generation, the verification wizard and the DB Manager are 
executed, corresponding dialogs appear if no active Java version is available. 

 Support for Database Systems Exasol and PostgreSQL 

Innovator supports the database systems Exasol for version 6.0.9 or higher and PostgreSQL for version 10 or 
higher. Each is supported by an model template and an add-on "Information Architect for *". 

 32-Bit Support Not Applicable 

Innovator's 32-bit support is no longer sustained for any operating system, server or client application. 

 Environment Variables in Engineering Actions 

Environment variables can also be used in the arguments of engineering actions. These are expanded in a way 
that inverted slashes contained in the environment variable will be replaced by slashes. Exceptions include 
network paths such as \\server name/share name/path. 

 Interface of Model Editor and Administration Program 

The interface of the model editor and the administration program has been changed to Microsoft metro 
themes. In the model editor, the color schemes red and gray are available for selection in the options for 
display. 

 Privilege "Versioning" Renamed "Use Model Fragments" 

The privilege "Versioning" has been renamed to "Use Model Fragments" in order to adapt it to the actual 
scope of action. 

 Support of Database Systems Updated 

Database system support has been updated and adapted. 

The profiles for the respective database systems support type system options from the following versions: 

• DB2 LUW for version 11 or higher 

• DB2 z/OS for version 11 or higher 

• Informix for version 12.10 or higher 

• Microsoft SQL Server for version 2017 or higher 
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• MySQL for version 8.0 or higher 

• Oracle for version 12 or higher 

Syntax alternatives from earlier versions are no longer supported. 

Notice the specific changes for the database systems during migration. 

 System Requirement  Java 

Java Standard Edition (SE) is required for the execution of engineering actions, documentation generation, the 
verification wizard, the database manager, and so on. Java 8, 9 and 10 versions are supported. Java SE 10 is 
recommended. 

From version 9 Java no longer supports the extension mechanism for the classpath. However, Innovator still 
supports loading jar files from the $(INODIR)/lib/ext directory, regardless of the Java version. 

 System Requirement .NET 4.6.1 

System requirement is .NET version 4.6.1 or higher. 

If you get an error message when installing on older systems, please check your .NET version and update it if 
necessary. 

Administration 

 Administration Program: Features Extended 

1. Program start without license server connection 

The administration program or the model editor can also be started if the license server (INOHOST) is not set 
or not running. In this case, a dialog appears in which Innovator environment variables can be changed. This 
makes it possible, for example, to enter a correct license server during normal program startup. 

2 Environment variables and services 

Backstage views are available for managing environment variables and services. The "Setup" tool is no longer 
applicable. The environment variables can also be viewed and edited in the Options dialog of the model editor. 

3. Version management 

The functions of the new version management have been completely integrated in the administration 
program. Model versions can be created and managed in an individually structured version tree. This allows a 
wide variety of procedures to be supported when working with technically consistent models. 

4. Filtering 

In the "Server" and "Version Management" tabs, the scope of the tree can be clearly reduced by naming 
patterns for e.g. project, repository and model. 

These filters as well as the view settings are stored for the user when the application is restarted. 

5. Table contents 

In the administration program, all table contents can be copied to the clipboard and pasted into Excel, for 
example. 

In tables with multiple selection, the selected lines are copied and in tables with single selection, all lines are 
copied. 
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 Managing Model Versions 

The version management has been completely redesigned and supplies a number of new features.  

Model versions can be created, changed and deleted in the administration program. In addition, the model 
servers of model versions can also be started and stopped on accessible computers in the network. Backups 
can be created for model versions, which are then started in read-only mode and are thus permanently 
protected against changes.  

Started model versions can be opened in the administration program or the model editor and edited in full in 
the model editor. 

In order to use these features, the new architectural components Agent and Bus must be installed. 

 User Management: Marking of Non-Existing Projects 

In the user rules, rules for projects that do not exist are marked with the placeholder symbol in the column 
"reachable". The tooltip of the icon reads "Project no longer exists". 

 User Management: Rule Shows Project Name 

In the central user management, the project name is displayed in the Project column instead of the INOHOST 
for better readability if the project with the INOHOST exists. 

The same applies to the dialog for creating and changing rules in the Project drop-down list. 

If the project name is displayed, the corresponding tooltip in parentheses shows the INOHOST. 

 Service Options 

If a service is created with the command "inosrv /bi <repository name>", then the default option "/O false" is 
omitted, since setting this option is not useful. 

Model Editor 

 Comparison of Single Profiles 

In the "Synchronize Model Elements" editor, selected profiles can be compared with each other using the 
"Compare Configuration" option. 

 Composite Structure Diagram Supports Association Classes 

Association classes are allowed as diagram contents of composite structure diagrams. 

The association class is always displayed as a classifier node. 

 Composite Structure Diagram: Display of Classifiers 

In the composite structure diagram, classifiers can be represented as classifier nodes or structured classifier 
nodes. In the context submenu Refactor you can switch to the other display. If the structured display contains 
nested classifier nodes, refactoring is not possible. In this case, the nested nodes must first be moved outside 
of the node. 

When refactoring, the attributes and ports displayed so far are adopted and all edges are also reassigned to 
the new display. 
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 Composite Structure Diagram: Improved Handling of Ports and Socket/Balls 

In the composite structure diagram, a port can be created directly on a part. The type of part becomes the 
owner of the new port. If no type exists, a selection of allowed types is offered and the part is typed when the 
port is created. 

Interfaces in socket/ball notation can be added to a port. If the port has not yet been typed, allowed interfaces 
are offered for selection and the port is thus typed. 

 Concept Diagram: Multiple Display of Concepts 

A concept can be displayed several times in the concept diagram. Besides the multiple addition, the 
representation of a node in the diagram can be duplicated. The multiple representations all refer to the same 
concept. 

 Creating New Models: Setting Options for Change Logging 

When you create a new model, you can specify change logging options. 

 Details Area: Expand and Collapse Subnodes 

The context menu of the details tool window provides the option of simultaneously expand and collapse all 
visible subnodes of a layer. 

 Dialog for Element Selection 

The "Select Multiple Elements" dialog has been revised. Instead of the "Add" button, the add area is displayed 
directly in the dialog, but can be collapsed using an expander. You can then easily add multiple model 
elements without having to open another dialog several times. 

To do this, select one or more model elements in the add area and confirm with the "Apply" button. The 
elements are added in the lower selection area. Removed elements are returned to the upper area. 

In appropriate cases, it is also possible to create a new element, which is then included in the add area from 
where it can be added. 

In cases where the "Select Multiple Elements" dialog is opened directly for adding (display with tree and list), 
you can select multiple model elements from different tree levels without closing the dialog. To do this, select 
one or more model elements from the list and confirm with the "Apply" button. The total number of 
transferred model elements is displayed. Repeat this for any tree node until you have adopted all desired 
model elements and close the dialog with the "Close" button. 

 Merge: Reference Time of the Comparison for Model Versions 

If a model version is selected as the right comparison model in the "Synchronize Model Elements" editor, the 
version creation time is also offered as the reference time. 

 Merge: Using Change-Sets 

Before starting the actual merge into the left model, the user can create a new change set if change logging is 
activated and the active change set is not empty. If the user answers the corresponding question with "Yes" or 
"No", then—as long as the "Synchronize Model Elements" editor is open—no further questions are asked. 

If change sets are selected for the merge in the right model, a log entry (time stamp, model name, link, ID, 
comment) is created for each of them in the comment field of the active change set of the left model. 
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 Sequence Diagram: Copying Possible 

Sequence diagrams can be copied. The referenced attributes, operations and signals are created as 
placeholders if necessary. 

If a referenced operation is found during insertion, the parameters of the referenced operation and the 
operation found must match both in number and direction. Otherwise, the operation found is rejected as 
incompatible and insertion is not carried out. 

 Sequence Diagram: Interaction Supports the Reconnection of Messages 

Messages can be reconnected in the sequence diagram with an action or behavior sequence or a lifeline. The 
message must have a message occurrence specification on the relevant side, i.e. it must already be connected 
to a lifeline or sequence. 

If the receiving side is changed for a message with called operation, then this operation must be available for 
the new lifeline. This restriction does not apply to messages with send signals. The response messages for call 
messages are always automatically reconnected together with the call message. 

 Sequence Diagram: Lifeline with Typed Attribute 

When creating lifelines, a represented element must be selected. In addition to the classifier of the interaction 
and its attributes, additional types are offered in the selection. If you select such a type, an attribute is created 
within the classifier, typed with the selected type and then used to create the lifeline. The additional types are 
also offered for selection when you change the "Represented Element" property. 

 Splitting Merged Tables 

Tables that were merged by a foreign key can be split again. 

The "included table" element, in which the merge is logged, is used for this purpose. In contrast to undoing a 
merge immediately, it cannot be guaranteed that splitting is exactly the inverse function, since the log is not 
complete (e.g. name and properties of elements involved). In addition, there may have been reworking by the 
user after the merge. 

In the case of database models that were created using a mapping from the ER model, the ER model is taken 
into account during splitting. In this case, splitting is limited to relationships that are directly related to the 
leading entity. However, here too, an exact inverse function cannot be guaranteed due to unlimited modeling 
possibilities. Therefore, a new mapping is recommended after splitting. 

 Use Case Diagram Allows Associations to Components 

In the use case diagram, associations can be created between components and use cases. 

 Verification Routine "Chapter has invalid filter 'Name'. [VFY548]" 

In the documentation structure, the chapters dealing with stereotype properties, text definitions and labels as 
well as their values allow you to filter the available elements. The check routine "Chapter has invalid filter 
'Name'. VFY[548]" returns a message if the filter-restricted list of available elements does not return a hit. 

 "Select an Element" Dialog: Stereotypes Filterable 

In the "Select an Element" dialog you can also select stereotypes in the "Element Type" filter if there are model 
elements of different stereotypes in the drop-down list. The "Type" column displays the stereotype instead of 
the element type. 
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 Backstage View "Verify & Export" 

The backstage view "Versioning & Export" has been renamed "Verify & Export", because the versioning 
functionality is offered in extended form  in the version management in the administration program. 

 Change DB Schema in the DB Manager 

In the "DB Manager" editor, the commands "Complete Database Schema" and "Refresh Database Schema" 
have been combined to form the "Change Database Schema" command to improve the transparency of the 
procedure. In the new dialog of the same name, select the import configuration "Import with add" or "Import 
with overwrite" along with the desired options. 

A file with new stereotypes can be specified for the import. 

 Composite Structure Diagram: Free Moving of Socket/Ball Nodes 

In the composite structure diagram, added socket/ball nodes are preferably being positioned at the level of 
the connected node. The socket ball nodes can be moved freely into structure nodes or directly to the diagram 
level. 

 Composite Structure Diagram: Representation for New Nodes Controllable 

If a classifier is dragged and dropped into the composite structure diagram, the kind of representation can be 
defined as follows by pressing additional control keys. 

 When dropping outside a classifier, you can use an additional key to define the creation as a structured or 
compartments display. 

- none: structured display 

- Ctrl: compartments display 

 When dropping within a structured classifier, the creation as part representation, structured 
representation and section representation can be defined by an additional key. 

- none: part representation 

- Ctrl: compartments display 

- Shift: structured display 

 Database Reverse Engineering Using JDBC 6.0 

Available database drivers for JDBC 6.0 are integrated for the reverse engineering of databases. 

 DB Configuration Via File 

The extended configuration of a database connection is done via a configuration file and no longer by selecting 
a configured engineering action. 

 DB Manager: Integer Data Type of Microsoft SQL Server 

In the DB Manager, the data types "int" and "integer" are treated equally for Microsoft SQL Server when 
comparing models and creating differences DDLs. 
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 Details Tool Window Initial With One Visible Level 

In the "Details" tool window the tree can be collapsed completely, so that only the topmost level is visible. In 
the options, set the display option "Visible Levels in the Details" to 0. 

 Diagram: Extend Selection by All Elements of the Same Stereotype 

In the diagram editor, the command Design>Edit>Select>Select Diagram Content (Ctrl+Shift+A) has been 
extended. If elements are already selected in the diagram, the selection is extended by all elements with the 
same stereotype. 

 Diagrams View Remains Visible When Creating Diagrams 

If the "Diagrams" view is selected in the "Model Contents" tool window, it remains visible when creating 
diagrams. There is no switch to the "Model Structure" view. 

 Documentation of Selected Elements 

If you create documentation for selected elements, elements that cannot be locked are also used directly as 
content of the documentation generation. 

 History for Dependencies 

A change history is stored for dependencies and all their specializations. 

When migrating from a previous Innovator version, the time of migration is automatically set as the 
generation time for each affected element. The name of the creator is defined as "Innovator". 

 Import of Model Fragments Revised 

When importing model fragments, the conflict resolution strategy has been improved. 

If the option "Identify elements by UUID" leads to a conflict, because the search by UUID finds a different 
element than the search by name, then the element found by UUID is always used. Until now, the element 
found by name was used despite the search strategy "Identify element via UUID". 

If the conflict option "The element already existing in the model is uniquely renamed" is selected, then the 
element found by name is uniquely renamed. 

If the option "The element newly created by the import is uniquely renamed" is selected, then the element 
found by UUID is uniquely renamed. 

If the option "Identify elements by namespace" leads to a conflict because the search by UUID finds a different 
element than the search by name, then the element found by name will be used as before. 

If the conflict option "The element newly created by the import gets a new UUID" is selected, the newly 
created element will get a new UUID. 

If the option "The element already existing in the model gets a new UUID" is selected, the element found via 
Name will get a new UUID. 

 Model Administrator Can Call Login Rules 

The model administrator can view the authorized users on the backstage "Administrative Tasks" even without 
the explicit user management right. 
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 Moving Diagram Nodes With the Right Mouse Button 

In the diagram, pressing and holding the right mouse button [RMB] allows you to move nodes while 
simultaneously increasing or decreasing the size of the container. Depending on the first direction of 
movement, the action is performed vertically or horizontally. 

 [RMB] 

- moves all nodes below or to the right of the line within the current container 

- the container is not increased or decreased if no nodes are moved 

 [RMB]+[Ctrl] 

- additionally increases or decreases the current container  

 [RMB]+[Shift] 

- moves all nodes below or to the right of the line independently of the container 

 [RMB]+[Ctrl]+[Shift] 

- additionally increases or decreases all intersected containers 

 Non-Exclusive Expander for Tool Windows 

For the tool windows Properties and Dependencies you can set whether a maximum of one or several 
expanders can be opened at the same time. The setting is made via the global "Exclusive Expander" option. By 
default, this option is disabled and multiple expanders can be opened. 

 Port Property "is behavior" 

The property "is Behavior" of ports is only available if the port's owning classifier contains a behavior and this 
behavior is marked as "is Classifier Behavior". The property is no longer offered if the behavior is used as a 
specification for an operation. 

 Printing Diagrams With Individual Sheet Layouts 

If an individual page setting is specified for a diagram in the page layout, the zoom factor is determined during 
printing in such a way that the print page is used most effectively. The zoom factor applies to all printed pages. 

 Register Tabs: Close All in Groups 

Grouped document and tool windows can be closed groupwise using the context menu. 

If specification texts are affected, you can choose to save them together. 

 Repeating the Generation of Documentation 

If you start a documentation generation and repeat it with the command "Redo Generation", then the 
originally selected elements will be used again. 

 Skipping Dialogs 

Certain query dialogs offer the possibility to permanently record a once made decision for this user, so that 
the query will be skipped in the future. The decisions made can be completely reset via the options, so that the 
queries appear again. 
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 Specification Editior: Adjustable Paragraph Spacing 

You can use a global option to specify the size of the spacing of standard paragraphs in the specification editor. 
The default setting is 11 points. 

The setting does not work if a paragraph contains specific information about the spacing. This can occur, for 
example, when text is copied from other applications. 

This setting has no effect on the generation of documentation. 

 Structure Elements with Enhanced Context Menu 

Structure groups and entries can be nested in structure definitions as needed. 

If you select a structure group or a structure entry, the menu commands for creating structure groups and 
structure entries are provided in the context submenu "Structure Nodes". The newly created element is placed 
below the selected element. 

If you want to create a structure group or an entry within a structure group, select the empty area below the 
name. 

 Synchronize Model Elements: Element Selection Based on Change Set 

In addition to the root element pairs, change sets of the right model can be used in the "Synchronize Model 
Elements" editor to define the elements for comparison. All elements that are listed directly in the change set 
are included. Their subelements are only included if the logging shows a change in the order sequence of 
subelements.  

When determining the automatic reference time, change sets—if contained in the comparative set—are taken 
into account. 

 Synchronize Model Elements: Sort Order of Subelements 

In the "Synchronize Model Elements" editor, the display and handling of the sort order of subelements has 
been changed. 

Instead of the property "Consecutive No." for subelements, the property "contained elements (sorted)" is 
displayed for the upper element. This allows you to specify whether the sorting of the right model should be 
taken over or whether the sorting of the left model should be retained. 

As with the multiple-value properties you can open a comparison window. 

In contrast to the multiple-value properties,"contained elements (sorted)" ignore which elements are 
referenced. It's all about the sorting itself. 

If you explicitly select one of the toggle buttons for a "multiple-value property" in the Properties area, then the 
sorting including the references of the corresponding side is used for this property during merging. 

With the property "contained elements (sorted)", only the sorting of the corresponding side is taken, but the 
references of the left model are left as they are. 

To copy individual references, you can select them in the comparison window or in the hierarchy area. 

If one of the two lists is empty, the "Merge" mode does not display the property "contained elements 
(sorted)", as the sorting is unique. 
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 Table Editor: Editing String-Value Stereotype Properties 

Values of string-value stereotype properties can be multiline. In these cases, only the first line is displayed in 
the Table Editor and the value cannot be edited directly in the cell. Via a button in the cell you can open a 
dialog to change the value. You can edit single-line values directly in the cell. 

 Undo Dependency Deletion 

For dependencies, the required access rights are always determined through the owner of the dependency 
when creating, changing or deleting them. If the target element is deleted, the associated dependency must 
also be deleted. Undoing the deletion causes the target element and the connected dependency to be created 
in this case. Creating the dependency works even if the currently used role does not have access rights to the 
owner of the dependency. 

 Change Set: Register Change for Extensive Selection 

In the window with the details for a change set, switching between the registers takes place in an acceptable 
time. Since it may take a long time to transfer an extensive selection when changing registers, a confirmation 
dialog appears. 

 Concept Diagram: Separate Moving of Node Name is Prevented 

In concept diagrams (such as ArchiMate diagrams), images can be assigned to the nodes. The name of the 
concept is therefore displayed outside the node. This name cannot be moved separately in the diagram. 
Moving the name to its own node used to change the owner of the node and the node was no longer visible. 

 Copy and Paste of a Diagram 

When copying a diagram, all contents required for the graphical representation are transferred to the 
clipboard. Pasting ensures that affected elements in the target diagram are compatible with those from the 
clipboard, otherwise a message appears. This applies in particular to the source and target elements of 
directed relationships. 

 DDL Import Supports Columns with GO 

Importing a DDL file supports table columns whose names begin with the characters "GO". The import does 
not terminate and imports all columns of the table. 

 Import of Model Fragments Prevents Contradicting Import of Profiles 

When importing model fragments, the contradicting import of profiles is rejected with an error message. 

 Mapping Does Not Change the Name of Sequence and Semantic Data Type 

Mapping from the conceptual model to the database schema does not change the name of an existing 
sequence or semantic data type. If an entity is selected for mapping, the sequence used in an attribute will 
also be mapped. 

 Mapping Maps Default Value 

Mapping from the conceptual model to the database schema maps an attribute to a table column and sets the 
properties "Default value" and "Set default value" of the table column to the values of the properties of the 
attribute. 
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 Merging Elements With Free Numbering 

The "Free Numbering" property is automatically assigned as a unique value when elements are created within 
a process. When merging, the value is adopted. In unfavorable cases, the situation could arise in which the 
value of free numbering was no longer unique within a process. Changing the "Free Numbering" property 
ensures that the values are unique. This may mean that a particular value cannot be merged due to the 
required uniqueness. 

 Navigation to Elements in the Verification Results Tool Window 

In the "Verification Results" tool window you can open a diagram which is displayed in the list of faulty 
elements. You will then see all messages concerning the content of the diagram. Open the diagram with the 
[Enter] key or double-click. You can open other model elements in the corresponding document editor. 

For model elements without an editor, double-click to access the occurrences in diagrams. 

For all model elements, press [Ctrl]+[Enter] to access the occurrences in diagrams. 

 Specification Editor for BI Tasks 

Renaming elements in the model results in updating the input/output areas of I/O specifications in the 
specification editor for BI tasks. 

 Specification Editor: Pasting Copied Elements 

If you paste copied model elements into a specification text of the same model, they are marked green as 
internal links. 

 Specification Editor: Removal of Tables Without Columns 

When specification texts are saved, tables without columns are removed. These tables are not visible, but can 
lead to generated documentations being unable to be opened by Word. 

 Specification Editor: Remove Shading 

If the background of a text area is colored in the specification editor and this shading is reset to "no color", 
then the color attribute is really removed and not set to white background. 

Configuration 

 Configuration Editor: Limit Selection to Locally Defined Entries 

In the configuration editor, deactivating the toggle command "View>Imported Entries" allows you to restrict 
the choice to the entries defined in the current profile on the right-hand side of the screen  in the tripartite 
views. 

 Ignoring Imported Configuration Contents 

Within an importing profile, certain imported configuration contents can be marked as "ignored". The affected 
configuration contents then behave as if they had not been defined. Configuration contents supported in this 
way are labels and text definitions in the "Stereotype" view, restrictions in the "Relationships" view and menu 
commands in the "Execution Rights" and "Menus" views. 
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Within a profile, the menu structure of imported profiles is also displayed for a stereotype. If the imported 
menus and menu commands are marked as "ignored", they are hidden in the model editor. Menu commands 
can be added to the imported menus. Menus of the same name are still combined into a joint menu in the 
model editor. 

 Reference to Another Element 

References between elements can be modeled using dependencies. These dependencies can be configured for 
extended use on the source and target side. If the extension is set, it will appear as a property of the source or 
target element. The display of the source or target element can also be switched off. The elements on the 
other side of the dependency are referenced via the property and, if necessary, a suitable dependency is 
created. 

In addition to the dependencies, the extended use can also be used for generalizations. Extended use as an 
option is only possible in profiles with a known type system. 

In callouts, extended use is used to display callout headings. The setting of the display at the source or target 
element is not taken into account for this. 

Migration to version 14.0 transfers the keywords as extended use without display at the element. 

 Static and Dynamic Value Lists for Integer and String Properties 

Static and dynamic value lists are supported for the following properties in the configuration: 

 Stereotype properties 

 Labels 

 Type system options 

If the specified property types are defined as "String" or "Integer", the properties "has value list" and "all 
values as list" are available. When the property  "has value list" is activated, there is an additional "Values" tab 
on which single-line values can be entered. 

When using the property type, the value list will be provided for selection. The new value does not necessarily 
have to come from the list, but can also be assigned freely. 

If the property  "all values as list" is activated, all currently used values will be provided in a drop-down list. 
Also here the value can still be freely assigned. The combination of both properties is possible. 

 Stereotype Properties Definable in Extension Profiles 

Stereotypes from imported profiles can be extended with stereotype properties. 

To separate the shipped profiles from profiles with customer-specific enhancements for updates, the model 
templates and migration profiles contain import enhancement profiles that are marked with the name suffix 
"Customization". These profiles can be locked without a lock message. 

 Database Options are Managed as Type System Options 

Within a profile in which a type system is known, type system options can be configured. The options are 
configured and edited uniformly for all SQL objects. This means that the stereotypes of the DB design can also 
have type system options (for example, tablespace as a stereotype of database object group). 

Configure the type system option like a stereotype property using Create>Type System Option. The type 
system option has a property "Type System". 
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To search for elements with specific type system options and values, use the "Search Type System Option" tab 
in the find dialog. 

The tables for DB options in the Table Editor are no longer applicable. The type system options are edited in a 
separate expander of the Properties tool window instead. 

If you do not want to use some of the type system options configured in the MID standard profiles in your 
company, create a stereotype redefinition for this stereotype in the customization profile of the corresponding 
type system via Edit>Redefine and remove the type system option in the "Visibility of Type System Options" 
tab of the stereotype. 

 Option "Name is placeholder" is Not Applicable for Create Templates 

In the configuration, the "Name is placeholder" option for create templates for relationships and roles is no 
longer applicable. When you create a new element, the name for the concerned element types is always 
automatically calculated from the selection. 

 Option Files for ER-DB and DB-ER Mappings Removed 

The subdirectories in $INODIR\java\M2M_ERDB\configuration\de\mid\data\ have been removed. If you used 
to use files from these subdirectories in your mappings, then use the files directly from the directory. Your 
mappings will remain fully functional. 

The following profile elements have been removed from the configuration profiles because the functions 
based on them do no longer use them: 

 for the profiles "Mapping ER - ... DB" the text definitions Mapping.Configuration.ERDB and 
Mapping.Configuration.DBER 

 for the profiles "... DB Modeling" the engineering actions 

 Redefinition of Stereotypes and Control for Visibility and Order in Dialogs 

Stereotypes can be implicitly changed in importing profiles through new stereotype properties (or type system 
options) or explicitly via the Edit>Redefine command. 

The settings for visibility or order in dialogs can be made in the profile in which the redefinition of the 
stereotype is located. 

It is also possible to reset the stereotype to the settings from the imported profile. 

 Stereotype Can Be Handled as Property 

The stereotype feature is offered in the configuration of "Visibility in Dialogs" and "Order in Dialogs". This 
makes it possible to hide the property Stereotype in the Properties tool window or to sort it to any position. 
This results in a changed order of properties, which means that the stereotype need not automatically appear 
in the first place. 

Migration hides the stereotype by default. 

 Uniqueness of Short Names 

Certain elements can have short names: entities and views and their attributes, also processes, tasks, and so 
on. 

Name restrictions can be configured separately for short names (Short Naming Constraints) and for short 
names taking names into account (Constraints for Short Name and Name). 
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If the names are taken into account, the name for an element without a short name will be used for the 
uniqueness comparison. 

 Visibility and Order in Dialogs 

In the configuration editor, the visibility and order  in dialogs can be defined for a selected stereotype. The 
corresponding tabs are only displayed if the stereotype is either directly created or redefined in this profile. 
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